
Quick Start: Microsoft Outlook 8.x for Macintosh 
 
Introduction 
 
This document is merely an introduction to the basic features of Microsoft Outlook — intended to help 
you get started quickly. Your Microsoft Outlook account has many advanced features (such as the 
Inbox Assistant, AutoSignature, POP3 access, etc…) that will not be covered here. You are encouraged 
to explore the program, and use the online help (located under the Help menu). If you have questions 
with regard to a specific feature of Outlook, please call the Help Desk at X4400. 
 
 
Starting Outlook 
 
When you first launch the Microsoft Outlook application, you are presented with a dialog box asking 
for your password. Your Username and Domain should already be filled in. Enter your password, and 
click OK. 
 

 
 
After you have entered the correct password, the program will continue to load, and you will then be 
ready to use Outlook. 
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Using Outlook 
 
The Outlook Window is divided into sections, each with their own function. Each section is detailed 
below: 
 

 
 
The left-most section is known as the Outlook Bar. This is called a “shortcut bar”, and serves as a place 
to store shortcuts (aliases) to frequently used items, including mail folders, and the Calendar feature of 
Outlook. 
 
The next section of the Outlook Window is the Folder List. This is where Outlook displays all your 
Private Folders, as well as the Public Folders. This list can be toggled on or off by selecting or 
deselecting “Folder List” under the View menu. 
 
Note: Several folders in the Folder List are used in the Microsoft Windows version of Outlook, but not 
in the Macintosh version. These folders are: Calendar, Contacts, Journal, Notes, and Tasks. These 
folders should be ignored when using the Macintosh client. 
 
The right side of the Outlook Window contains the Information Viewer. This section displays the 
contents of the folder currently selected in the Folder List. 
 
Former users of Microsoft Mail may remember that the Inbox Window used to be a separate entity 
from the Microsoft Mail window, which enabled users to close the Inbox but still remain logged into 
their mail accounts. Microsoft Outlook does not have that capability — if you close the Outlook 
Window, the program exits, and you must login to the server again to check for new mail. However, 
there are a couple of ways to keep Outlook open without it obscuring too much of your screen. The 
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first, and most effective way is to simply choose Hide Microsoft Outlook from the Application menu 
(the menu on the far right of the menu bar). This will completely hide Outlook, but it will remain 
running; to view it again, simply make it active by selecting it from the Application menu, or choose 
Show All from the Application menu. Another option is to click the Collapse Box (also known as 
WindowShade) on the title bar of the Outlook Window. Click the box again to expand the window to 
its original size. (The Collapse Box is the small box with the horizontal “line” running through the 
middle, on the far right-hand side of the title bar.) 
 
 
The Outlook Bar 
 
By default, the Outlook Bar contains shortcuts to the following items: Inbox, Calendar, Outbox, Sent 
Items, and Deleted Items. Clicking on any of these icons makes that item active. For example, clicking 
on the Inbox icon makes the Inbox the currently selected folder within the Folder List, and displays its 
contents in the Information Viewer. Clicking on the Calendar icon activates the Calendar function of 
Outlook. Additional items can be added to the Outlook Bar by simply dragging the desired item onto 
the Outlook Bar, providing easier access to frequently used items. The item itself will not be moved, 
instead a shortcut (alias) will be created on the Outlook Bar for that item. To remove an item from the 
Outlook Bar, hold down the Control key while clicking on the item, and then select Remove from 
Outlook Bar from the menu that pops up. 
 
 
The Folder List 
 
The Folder List allows you to see all the mail folders within your mailbox, as well as provides you with 
access to the Public Folders. The Folder List presents all the mail folders in a collapsible directory 
hierarchy. Any folders found under “Mailbox” are stored in your account on the mail server, and only 
you have access to them. Any items stored under “Public Folders” are stored on the mail server also, 
but everyone has access to these items. Any items that appear under “Personal Folders” are stored on 
your local hard drive, and only you have access to them. To view the contents of a folder that contains 
subfolders, click the “+” next to the folder to expand the directory. To display a folder’s contents in the 
Information Viewer, click once on the folder’s icon or name in the Folder List. 
 
Note: Personal Folders are not configured by default, they are used to store mail on your hard drive to 
reduce excessive use of server space. If your mailbox size was not over the allotted amount at the time 
your account was migrated to Outlook, then Personal Folders were not set up on your machine. If you 
wish to have them configured, please contact the Help Desk (X4400). 
 
 
The Information Viewer 
 
The Information Viewer shows the contents of the currently selected folder. When the currently 
selected folder contains mail messages, the Information Viewer displays headings that provide you 
with information about each message’s importance, the presence (or lack) of an attachment, the sender, 
the subject, the time, date, and size of the message. Messages that appear in boldface text have not yet 
been read, while messages that appear in plain text have been read. To read a message, double-click it 
in the Information Viewer, and a new window will open with the contents of the message. It is 
important to note for previous Microsoft Mail users that the envelope icon does not change to reflect 
the message status (read/unread) as it did in Microsoft Mail.  
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The Outlook Toolbar 
 
At the top of the Outlook Window is the Outlook Toolbar. The function of each item on the toolbar can 
be displayed by holding the mouse pointer over the icon in question — this applies to toolbars within 
message windows and within the Outlook Calendar as well. The toolbar allows you to quickly access 
common functions, such as composing a new message, replying to a message, deleting a message, 
printing a message, etc…. 
 
 
Composing a New Message 
 
To compose a new message, you can either click the New Message button on the toolbar (the third 
button from the left), or you can select New Message under the Compose menu. When you do so, a 
new window opens, containing the new message form. This form is analogous to the form used in 
Microsoft Mail, and is filled out similarly. However, there are several new features, as well as new 
ways to enter certain information. 
 

 
 
Note: If your window is missing any of the toolbars shown above, they may be activated by selecting 
the missing toolbar under the View menu. 
 
As you can see, there are significantly more options available to you here than there were in Microsoft 
Mail. With Outlook, you have more control over the appearance of the message, including formatting, 
color, and fonts. Common functions such as attaching a file, requesting a read receipt, changing the 
message priority, etc… can be accessed through the toolbar as well as through the menus. 
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There are several different ways you can address your email message. If you know the recipient’s 
address, you can simply type it into the field labeled “To…”. Make sure you type just the address — no 
special punctuation or extra characters are required. (Example: smith@aol.com) If you want to send a 
message to someone within the Health Center, or someone whose address you have already entered 
into your Personal Address Book, then you have two choices: The first option requires you to type part 
(or all) of the person’s (last) name in the “To…” field and then select Check Names under the Tools 
menu. Outlook will then lookup that person’s address. As long as they are listed in either the Global 
Address List or your Personal Address Book, their address will be found. If Outlook finds more than 
one person whose name matches what you have entered, you will be presented with a list of possible 
matches. The second option is similar to the way messages were addressed in Microsoft Mail. Clicking 
on the “To…” button pops up a list of users from which you can choose recipients for your message. If 
you want to change the current active list (for example, if you want to choose a user from your Personal 
Address Book, instead of the Global Address List), then click on the list popup menu in the upper right 
of the dialog box, and select the desired list. 

 

 
 
 

Once you have the message addressed, you can enter the subject line and your message text in the 
appropriate fields. If you want to attach a file, request a read receipt, check your spelling, or otherwise 
add to your message, you may do so using either the buttons on the toolbar or by using the menus. 
When the message is complete, send it by clicking on the Send button (the large button to the right of 
the “To…” field).  
 
 
Outlook Calendar 
 
The Calendar function of Microsoft Outlook is accessed by clicking on the Calendar button on the 
Outlook Bar. The first time you use the Calendar, it will ask you for your schedule file; choose the 
option that creates a new schedule file. The Outlook Calendar allows you to track your schedule, 
schedule meetings and appointments, and request meetings with other Outlook users. In addition, you 
can give other individuals permission to view and/or modify your calendar from within their own 
Outlook account. 

mailto:smith@aol.com�
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Outlook Web Access  
 
Microsoft Outlook Web Access (OWA) is a subset of Microsoft Outlook available via the Microsoft 
Exchange Server. OWA allows you to securely access your e-mail, personal calendar and group 
scheduling through your Web browser. OWA provides a subset of Outlook functionality and requires 
an active connection to the Internet. OWA is NOT intended to be a replacement for the full featured 
Outlook client. 
 
Outlook Web Access does not download mail to the client, so there is no risk of users accidentally 
copying messages to another user’s hard disk. To use Outlook Web Access, a Web browser that 
supports frames, Java controls and JavaScript must be installed. (Netscape Navigator 3.0 (or later) and 
Microsoft Internet Explorer 3.0 (or later) have been tested.) 
 
Features of Outlook Web Access include: 
 
Outlook Web Access features include many of the same features available in the full-version of 
Outlook including:  

• Basic e-mail  
• Address mail using the Global Address Book (indirectly) 
• Send and receive file attachments and hyperlinks 
• Set message priority 
• Request delivery and read receipts 
• Use hierarchical folders and the Outlook Bar 
• Group and sort messages in a folder based on standard fields 

• Basic calendar and group scheduling 
• Create one-time or recurring appointments in your personal calendar 
• Access day and week views of calendar 
• View free and busy times of multiple users and resources when scheduling a 

meeting 
• Automatically send and respond to meeting requests in e-mail 

• Basic public folder access  
• Access custom table views on public folders 
• Group and sort messages in a folder based on standard fields 

 
Limitations of Outlook Web Access 
 
Outlook Web Access does not include the following advanced features of Outlook:  

• General 
• Offline use — users must connect to Microsoft Exchange Server to view 

information 
• E-mail 

• Personal Address Book 
• Spell checking 
• Send and receive rich text or HTML mail messages 
• Microsoft Exchange digital encryption or signature support 
• S/MIME support 
• Message flags and inbox rules 
• Three-pane view, drag and drop to folder 
• Search for messages 

• Calendar and group scheduling  
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• Monthly view and other customized views of calendar 
• Appointment list views 
• View details with free and busy 
• Drag and drop to move appointment 
• Track acceptance of meeting attendees 
• All-day or multiple-day event 

 
 
How to Access and Use Outlook Web Access  
 
Important notes: 
• You do NOT need to set any options nor do you need to make any configuration changes in your 

web browser to use Outlook Web Access.  
• If the browser you are using has any Mail options on the Browser Menu or Toolbar, they should 

not be used with Outlook Web Access — they will not work. 
• You must have an UCHC Exchange (Outlook) account to use this procedure.  
• If you have Cookies disabled in your browser, you will not be able access your Outlook account. 

Please enable Cookies if you had previously turned them off. (Cookies were enabled by default 
when your browser software was installed.) 

 
Ensure your computer has an active connection to the Internet, and launch your web browser. Go to the 
following URL: 

http://exchange.uchc.edu/exchange 
The following screen should appear: 
 

 

http://exchange.uchc.edu/exchange�
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In the “Log On” field, enter your Username and then press <RETURN>. A dialog box will then 
appear, please enter the following and then click OK: 
 
User Name :   UCHC\<username> 
Password:       <password> 
 
Note: Between UCHC and your username, the “\” is the backslash — a forward slash will not work. 
 
After the information is authenticated, the Outlook Web Access window opens like any other internet 
web site. The Toolbar for Outlook appears at the top of the current window, and is the toolbar to use to 
migrate through the Outlook options (see below).  
 
Note: When finished, be sure to use the “log off” button in the Outlook Tool Bar to disconnect from the 
Exchange server. 
 
 

  
Log Off   Outlook Bar   Find Names   Folder List   OWA Toolbar   Information Viewer   Compose New 
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Outlook Tool Bar 
Helpful Hints: 
 
New Messages: As shown on the right side in the picture above, click on the underlined Compose new 
hyperlink. (Mail Message is the default, click on the down arrow next to Mail Message to select a 
different option.) A New message window (shown below) will display. 

 
 
Addressing new mail: OWA uses the Global Address Book on the Exchange server to find names 
contained in the list. The Global Address Book is NOT directly available for viewing to select names. 
 
The best way to address a message is to type in the internet address or, if a UCHC user, type in Last 
Name, First Name. Typing in a last name only will force a search. If multiple users are found, a list of 
possible matches will be displayed. If the person you are looking for appears on the list, click the radio 
button next to that person’s name, and then click the “Accept These Choices” button. 
 
Attachments: You can attach a file by clicking on the Attachments tab. You can set options by 
clicking on the Options tab. When ready to send the message, click on the Envelope icon on the New 
Message Toolbar. 
 
Hint: Remember that you can identify the function of a particular tool on the toolbar by holding your 
cursor over the icon to show the Tool Tip (only with some web browsers).  
 
Outlook Bar: The Outlook Bar in OWA differs from the Outlook Bar in the full version of Outlook. 
The selections here are: 
• Inbox — access your mail 
• Calendar — access your calendar 
• Contacts — access your contacts 
• Find Names — search through the Global Address Book 
• Public Folders — access information in the shared folders 
• Options — set the "Out of Office" Assistant, Time Zone and Calendar Options 
• Log Off — disconnect from the Exchange server 
 
Note: Calendar and Contacts in OWA do not directly relate to features in the Macintosh Outlook 
client. The Contacts feature is not supported by the Outlook for Macintosh client. If you want to use the 
Calendar function through OWA and your Outlook for Macintosh client, you must place a check in the 
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box labeled, “Use Microsoft Schedule+ as my primary calendar.” This option is available by clicking 
Options on the OWA Outlook Bar. Failure to do so will cause OWA to use a different schedule file than 
your Macintosh Outlook client, and your schedule information will not be shared between the two 
calendars. 
 
 
Viewing your Private Folders 

 
 
Click on the Folder icon (with the arrow pointing up) to display your Mailbox (Private) 
folders. 
 
 

 
 
Using the Global Address Book 

 
 
 
Find Names accesses the Global Address Book. Matching 
names are returned in a display window. (The Global Address 
Book is not directly accessible). You can click on the returned 
name (it will be underlined), and then at the top of the new 
window that pops up, click on the “Send Mail To” link to 
address a new message to that person. 
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